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A joint program of the

Oregon Department of Transportation and the
Oregon Department of Land Conservation and Development
Better Ways to Better Places

TGM APPLICATION CHECKLIST

The electronic Cover Sheet, Application Form, and this Application Packet can be downloaded at: http://egov.oregon.gov/LCD/TGM/grants.shtml
· Submit your application materials electronically via ODOT’s FTP site using the instructions on pages 3 and 4. One project per application submittal. 
Electronically submitted application materials must include:
· Electronic Cover Sheet

· Application Form (please limit to 10 pages)

· Project area map

· Letters or resolutions of support. Note: these may be submitted separately from the application. Letters and resolutions of support may be submitted through June 28, 2013. Those submitted after June 14, 2013 must be identified with the jurisdiction and project name and submitted electronically via ODOT’s FTP site.
· Mail or hand-deliver 1 paper copy of all application materials as submitted electronically. Paper copy must be submitted on white, three-hole punched, 8-1/2” x 11” recycled paper. NO covers or additional binding. 
Consultants: Consultants may prepare the jurisdiction’s application. Please be aware that uncompensated consultants are not eligible to participate in the project itself. Consultants who are paid to prepare the application may be eligible to participate in the project. Contact Cindy Lesmeister at 503-986-4349 if you have questions.

Electronic applications must be received by 4:00 p.m, Friday, June 14, 2013.
Mailed copy of applications must be be POSTMARKED by Friday, June 14, 2013 and sent to:
Cindy Lesmeister

Transportation and Growth Management Program

ODOT Mill Creek Building

555 13th Street NE, Suite 2

Salem, OR  97301
Sign Up for Emailed Updates: You may subscribe to receive announcements concerning the TGM Grant Program, other TGM Community Assistance Programs, as well as the ODOT STIP Enhance Funding Program: Subscribe to Transportation Funding Programs email list
Instructions for Electronically Submitting your TGM grant application:
File Naming
Please follow the following naming convention for each of your files:
<Applicant Name>_<Project Title>_<Document Type>
Please note that “Document Type” should indicate whether the document is a cover sheet, application, map, or letter of support. The applicant name, project title, and document type should be separated by underscores.

Submitting your application
1.   Go to ODOT’s FTP site at: ftp://ftp.odot.state.or.us. 
2.   Confirm that FTP folder view is enabled. Press Alt on your keyboard to display the menu bar. Under the Tools menu in Internet Explorer, click on Internet Options and navigate to the advanced tab. Scroll down and ensure that ‘Enable FTP folder view’ is checked. If it is not, check it and click ‘OK’.
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3.   Under the View menu click, ‘Open FTP Site in Windows Explorer’. Please note that depending on your version of Internet Explorer, the wording may differ. Refresh the page if the option is not available.
4.   Navigate to the incoming directory.
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5.   Now place files in the TGM Grant Applications folder. You may do this by dragging the files into this folder, or by copying the files and pasting them into this folder.

Please Note

If you do not have access to Internet Explorer, please email your applications to TGMGrantApps@odot.state.or.us. 

Use the following convention for the email subject line:  

<Project Name> - <Document Type>
Project name and Document Type should be separated by dashes.

Note that there is an 8MB limit for attached files sent via email. If the combined file size of your application documents exceeds 8MB, first reduce your file sizes as much as possible.  If the documents still exceed 8MB, send the documents in more than one email using descriptive subject lines using the following convention:

<Project Name> - <Document Type> - <Number in Email Series>

Please note the project name, document type, and number in email series should be separated by dashes.

To reduce your file size we strongly encourage using .pdf formatted documents for all maps and letters of support. If you are having trouble with .pdf formatting, please send an email to TGMGrantApps@odot.state.or.us with the subject line “Creating PDFs” or call Rebecca Coffelt at 503-986-4254

Introduction & Grant Basics

The Transportation and Growth Management (TGM) Program invites you to apply for funding in the 2013 grant cycle. The TGM Program provides resources to help Oregon communities prepare transportation and land use plans to respond to pressing transportation, land use, and growth management issues.
The TGM Program is a joint effort of two state agencies: the Oregon Department of Transportation (ODOT) and the Oregon Department of Land Conservation and Development (DLCD). The mission of TGM is to support community efforts to expand transportation choices. By linking land use and transportation planning, TGM works in partnership with local governments to create vibrant, livable places in which people can walk, bike, take transit or drive where they want to go.  
TGM has the following program goals:

1. Help local governments plan for well-connected, multi-modal transportation systems that serve land use objectives and meet the requirements and intentions of the Transportation Planning Rule.
2. Help local governments plan for sustainable and efficient transportation systems, land use, and development patterns that meet transportation needs and promote economic vitality.
3. Strengthen the capacity of local governments to manage urban growth and to translate plans into how communities get built.
4. Minimize the cost of transportation facilities and other infrastructure recognizing the very limited funding available for system completion and expansion for all modes, and maximize the return on investment through good planning.
5. Help local governments contribute to meeting transportation-related statewide greenhouse gas emission reduction goals.
6. Educate decision makers and the public on transportation and land use best practices that provide modal choice and enhance urban livability.
7. Partner with and support state agencies and programs where their actions advance TGM goals and objectives.

TGM supports local government planning that accomplishes one or more of the following objectives:

Provide transportation choices to support communities with the balanced and interconnected transportation networks necessary for mobility and economic growth. 

a. A balanced, interconnected, and safe transportation system that provides a variety of transportation options and supports land uses.

b. Appropriately sited, designed, and managed local, regional, and state transportation facilities and services that support the movement of goods and services 
c. Mobility choices for those with limited options.

d. Safe and convenient walking, biking, and public transportation opportunities to support an active lifestyle.

Create communities composed of vibrant neighborhoods and lively centers linked by convenient transportation. 

e. Livable towns and cities with a mix of housing types, work places, shops, schools, and parks for people of all ages and income.

f. Well-located activity centers, including schools and other government services, which are accessible to pedestrians, bicyclists, and transit users. 

g. A healthful, safe, and pleasing physical environment supportive of the social and cultural needs of all the community residents.

Support economic vitality by planning for land uses and the movement of people and goods.

h. Thriving existing neighborhoods and centers and well-planned new growth that accommodate existing and future residents and businesses. 
i. Well-located and accessible industrial and employment centers. 
Save public and private costs with compact land uses and efficient transportation patterns. 
j. Urban growth accommodated within existing communities, thus minimizing, delaying or providing an alternative to an urban growth boundary expansion. 
k. Future transportation needs accommodated within the existing or improved system thus minimizing, delaying or providing an alternative to constructing additional major infrastructure projects.
Promote environmental stewardship through land use and transportation planning. 
l. Transportation systems and land use patterns that protect valuable natural resources, promote energy efficiency, and reduce emissions of air pollution and greenhouse gases.

The TGM Program is primarily funded by the federal Moving Ahead for Progress in the 21st Century (MAP-21), under an agreement with the Federal Highway Administration with additional staff support and funding provided by the State of Oregon.  Awarded projects are administered by TGM on behalf of a local jurisdiction according to state and federal requirements.
The TGM Program awards grants on an annual basis.  All grants have a preferred completion period of 18 months from the “Notice to Proceed” but may add up to an additional six months for completion.  Award amounts generally range between $75,000 and $200,000. 

The TGM Program is committed to coordinating with and supporting other state programs. TGM planning grants can help local governments compete for state funding from such programs as:
· Oregon Main Street Revitalization Programs (http://www.oregon.gov/OPRD/HCD/SHPO/Pages/mainstreet.aspx) 

· ODOT Enhance Funding (http://www.oregon.gov/ODOT/TD/TP/Pages/stip_guide.aspx) 

· ODOT - Public Transit Division (http://www.oregon.gov/ODOT/PT/Pages/index.aspx) 

· Department of Land Conservation & Development (http://www.oregon.gov/LCD/Pages/grants.aspx)

Eligible Applicants

Cities, counties, some special districts, councils of governments (COGs) (working on behalf of member governments), tribal governments, metropolitan planning organizations (MPOs), and metropolitan service districts. Special districts – such as school districts – may be eligible as part of a joint application with a local government for an otherwise eligible project.
Grant Selection

Projects are selected on a competitive basis within each of the five ODOT regions. Applications are scored using the grant criteria on page 10. Consideration will be given in scoring to ensuring a fair distribution of grant funds to smaller communities. TGM consults with other state agency staff to gain further insights about proposed TGM projects.
In October 2013, successful applicants will receive a grant award letter. The successful applicant and a TGM grant manager will work together to prepare a project statement of work, select a consultant (as appropriate), and complete an intergovernmental agreement (IGA).
Initial project statement of work negotiations must be completed by the end of January 2014 or the grant award may be withdrawn. The grant award is not final until the intergovernmental agreement with ODOT and the local government is signed by all parties.

Use of Consultants
For projects using consultants, ODOT, rather than local grantees, will contract with consultants. Using ODOT policies and procedures that meet state and federal requirements, TGM staff will work with jurisdictions to select the project consultant that best fits the specific planning services needed.
Grantee Obligations
Match: Grantees must provide a match of 12% or more of the total project cost. This may be in the form of cash or staff time and direct project expenses. Communities defined as “distressed” by the Oregon Business Development Department may request a partial match waiver. The list of communities meeting the definition of distressed is available at:

http://www.oregon4biz.com/Oregon-by-the-numbers/oregon-economic-data/Distressed-Areas-in-Oregon/



The ways to fulfill match requirements vary:
· Grantees not using consultants will bill TGM for eligible project costs, such as in-house staff labor or other eligible items. TGM will reimburse the grantee for those costs, less the required match amount.
· Grantees using consultants must submit match reports that document eligible local project costs to meet the match requirement.

· Grantees using consultants and being partially reimbursed for their own work will bill all of their work and be reimbursed for those costs less the required match. Consultants will bill and be paid at 100%.

· Grantees may send cash directly to TGM at signing of IGA.
Please Note: As a grant award condition, grantees who have any unmet match obligations from previous TGM grant projects must document that the match was provided or pay the balance of unmet match within three weeks of notice of new grant award, or the award will be withdrawn.
Statement of Work: Grantees are expected to help prepare a project statement of work. This is done before an intergovernmental agreement is signed and is not a reimbursable expense.
Project Management: Local commitment is the key ingredient to a successful TGM grant project. Grantees must provide a project manager who will:

· monitor and coordinate work, including consultant work;

· work with the TGM grant manager to ensure completion of all work on time and within budget;

· serve as principal contact person for the project;

· review consultant work products and payment requests; 

· prepare progress reports and reimbursement requests; and

· prepare match reports.
As a condition of grant award, grantees will be asked to provide written commitment that they will meet all grantee obligations in a timely manner.
Eligible Costs
TGM grants and required match can be spent only on “direct project-related costs.”  Eligible costs include salary of local government employees assigned to the project, postage, travel, supplies, and printing.
Equipment purchases and indirect costs, including general administrative overhead, are not eligible costs unless you have a federally approved indirect cost plan. Local expenses for persons or firms who contract with a local government to provide planning or other services are not eligible costs.
Costs incurred prior to signing an intergovernmental agreement are not eligible project costs. This includes costs of preparing the grant application, preparing a statement of work for the intergovernmental agreement, and selecting a consultant.
Title VI/Environmental Justice/Americans with Disabilities: Awarded projects are expected to consider environmental justice issues, which is the fair treatment and meaningful involvement of all people regardless of race, color, national origin, or income with respect to the development, implementation, and enforcement of environmental laws, regulations, and policies. The public involvement program must include specific steps to provide opportunities for participation by federal Title VI communities. Grants that include planning for pedestrians must consider Americans with Disabilities Act requirements.
For more information, see:
http://www.fhwa.dot.gov/environment/ej2000.htm  
" 
http://www.justice.gov/crt/about/cor/coord/titlevi.php


http://www.ada.gov//2010ADAstandards_index.htm
Timeline

June 14, 2013
Grant Applications due by 4:00 p.m.
June-September 2013
Application scoring and ranking
October 1,  2013
Project award announcements
January 31, 2014
Must have reached agreement on a detailed statement of work sufficient to select a Consultant or prepare an intergovernmental agreement if no consultant will be used
April 2014
Must have completed consultant selection, if applicable
Grant projects should be completed18 months from IGA Notice to Proceed

Projects designed to take more than two years from award to completion or more than 18 months from Notice to Proceed should be identified as such in your application and may be programmed beyond the two year grant period. Continued funding beyond the two year grant period is subject to available funding and continued eligibility of the project.
ELIGIBLE PROJECTS

CATEGORY 1 – TRANSPORTATION SYSTEM PLANS
Purpose

To help local governments develop and update transportation system plans and implementing measures that implement the Transportation Planning Rule (OAR 660-012-0045), 1999 Oregon Highway Plan, and 2006 Oregon Transportation Plan, or reduce reliance on the state highway for local travel needs.

Eligible Uses

Projects in this category plan for transportation facilities inside Urban Growth Boundaries (UGB’s), in urban unincorporated communities, and along rural highway corridors. Projects proposed for areas being considered in a UGB amendment process may be eligible, but TGM will give careful consideration to whether the proposed project is reasonably achievable and timely (TGM scoring criteria #1 and 3).  Category 1 projects typically include preparation and adoption of:

· Complete Transportation System Plan (TSP) preparation and adoption that results in a balanced, multi-modal system that addresses and accommodates a range of transportation needs, including movement of freight;
· Discrete portions of TSPs, including such elements as: local street system plans, bike and pedestrian plans, transit plans, transportation system management plans, demand management plans, safe routes to school-related plans, parking plans, freight plans, etc.;
· TSP updates, for example, to address new needs, comply with new state or federal regulations, maintain consistency with a regional transportation plan, or plan for areas newly brought into the UGB.
· TSP implementing measures, such as street design plans, subdivision and site design standards, safe routes to school-related plans, capital improvement plans and other funding strategies and programs, and ordinance amendments required by the Transportation Planning Rule;

· Refinement plans included in an adopted TSP such as corridor plans, highway segment designation, interchange area management plans, or other planning to implement the 1999 Oregon Highway Plan;

· Project-level planning for facilities or improvements included in an adopted TSP that results in resolving important transportation and land uses issues required to move projects forward toward funding consideration;
· Detailed access and circulation planning to improve readiness of key employment centers;
· Other innovative transportation-related projects that are consistent with TGM objectives – contact our staff to discuss your ideas.
CATEGORY 2 – INTEGRATED LAND USE AND TRANSPORTATION PLANNING

Purpose

To help local governments develop integrated land use and transportation plans that promote compact, mixed-use, pedestrian-friendly development; increase opportunities for transit, walking, and bicycling; or reduce reliance on the state highway system for local travel needs. 
In recent grant cycles, TGM has received fewer Category 2, Land Use and Transportation Planning applications. While there is an ongoing need for communities to keep their transportation systems plans updated, and TGM will continue to provide funding to do so, we are especially interested in hearing your ideas for innovative projects that plan for land use and transportation in an integrated way.
Eligible Uses

Projects in this category combine land use planning with transportation facility planning to meet transportation needs inside UGBs, urban unincorporated communities, and urban reserve areas. Category 2 projects may include preparation and adoption of:

· Transportation-efficient land use plans for an entire urban area – in metropolitan areas, such plans should be designed to address state goals for reducing greenhouse gas emissions that contribute to climate change;
· Land use and transportation concept plans for areas that have been brought into a UGB;
· Interchange Area Management Plans (if land use focused);
· Specific development, redevelopment, and area plans for a downtown, mixed-use commercial area, or neighborhood, including designation of a multimodal mixed-use area (MMA, as defined in OAR660-012-060(10)) as part of such a plan;
· Implementing measures, such as TSP amendments, code amendments, infill and redevelopment strategies, funding strategies and programs, and intergovernmental agreements;
· Transportation and land use planning related to the Oregon Main Streets Program;
· Other innovative land use and transportation planning-related projects that are consistent with TGM objectives – contact our staff to discuss your ideas.
GRANT ELIGIBILITY REQUIREMENTS

Applications are reviewed on a pass/fail basis on each of the following criteria. Applications found to not meet each of these requirements will not be scored against the award criteria and will not be awarded a grant.
1.
Clear Transportation Relationship

A proposed project must have a clear transportation relationship and produce transportation benefits. A project must entail research, analysis, evaluation of alternative scenarios, development of implementation measures, or public involvement that results in a transportation plan, land use plan, or other product that addresses a transportation problem, need, opportunity, or issue of local or regional importance.
2.
Adoption of Products to meet Project Objectives

A proposed project must include preparation of an adoption-ready product or products that directly address the project objectives, such as a transportation system plan, comprehensive plan amendment or element, land use regulation, or intergovernmental agreement. Projects that will primarily do outreach, research, study an issue, or compile data are not eligible.
3.
Support of Local Officials

A proposed project must clearly demonstrate that local officials understand the purpose of the grant application and support the outcomes of the project. A letter or resolution of support from the governing body of the applying jurisdiction is required to be submitted with the application to meet this requirement.
AWARD CRITERIA

Applications are scored on a range of criteria and receive up to 100 points. Projects are selected based on the points scored, the grant amounts requested, the estimated amounts TGM believes may be required to complete a project, the amount of grant dollars available for award within a geographic region, and the balance of grant dollars between Category 1 and Category 2 projects.
1.
Proposed Project Addresses a Need and Supports TGM Objectives

The project clearly and effectively addresses a local or regional transportation or transportation-related land use issue, problem, need, or opportunity through achieving one or more of the following TGM objectives.
Provide transportation choices to support communities with the balanced and interconnected transportation networks necessary for mobility and economic growth. 

a. A balanced, interconnected, and safe transportation system that provides a variety of transportation options and supports land uses.

b. Appropriately sited, designed, and managed local, regional, and state transportation facilities and services that support the movement of goods and services 
c. Mobility choices for those with limited options.

d. Safe and convenient walking, biking, and public transportation opportunities to support an active lifestyle.

Create communities composed of vibrant neighborhoods and lively centers linked by convenient transportation. 

e. Livable towns and cities with a mix of housing types, work places, shops, schools, and parks for people of all ages and income.

f. Well-located activity centers, including schools and other government services, which are accessible to pedestrians, bicyclists, and transit users. 

g. A healthful, safe, and pleasing physical environment supportive of the social and cultural needs of all the community residents.

Support economic vitality by planning for land uses and the movement of people and goods.

h. Thriving existing neighborhoods and centers and well-planned new growth that accommodate existing and future residents and businesses. 
i. Well-located and accessible industrial and employment centers. 
Save public and private costs with compact land uses and efficient transportation patterns. 
j. Urban growth accommodated within existing communities, thus minimizing, delaying or providing an alternative to an urban growth boundary expansion. 
k. Future transportation needs accommodated within the existing or improved system thus minimizing, delaying or providing an alternative to constructing additional major infrastructure projects.
Promote environmental stewardship through land use and transportation planning. 
l. Transportation systems and land use patterns that protect valuable natural resources, promote energy efficiency, and reduce emissions of air pollution and greenhouse gases.

Up to 40 points: Projects that address an issue, problem, need, or opportunity with a clear expected outcome will receive more points. Projects that meet one or several TGM objectives in a substantial, integral way will receive more points than projects that meet one or more TGM objectives superficially.
2.
Proposed Project is Timely and Urgent

The application demonstrates timeliness and urgency. The project is needed now to:

· address pressing local transportation and land use issues;

· make amendments to local plans or regulations necessitated by changes in federal regulations, state requirements, or regional plans;

· make amendments to local plans or regulations necessitated by changes that were not anticipated in previous plans including growth, changes in land use patterns, or changes in available funding;

· build on, complement, or take a necessary step toward completing other high priority community initiatives; or

· resolve transportation- or land use-related issues affecting the project readiness of local, regional, or state transportation projects for which funding is expected to be obligated within the near future.
Up to 25 points: Projects that match well with the TGM grant timeline will receive more points. Projects or project elements that are not clearly timely or urgent will receive fewer points.
3.
Proposed Project Approach is Reasonable

The application demonstrates a clear approach to achieving the expected outcome and results in consideration for adoption. Where substantial coordination with other local, regional, and state planning efforts occurs (or will need to occur), the mechanisms and responsibilities for the coordination are clear. 

Up to 15 points: Project approaches will receive more points if they clearly address the project need, are achievable considering scope, objectives, and benefits of the project, and are at a level of detail appropriate to the community. 

4.
Proposed Project has Community Support

The application demonstrates that there is local support for the project objectives, a commitment to participate, and a desire to implement the expected outcome.
Up to 5 points: Projects with written support from stakeholders including partner jurisdictions, community institutions, or businesses will receive more points. Letters of support should demonstrate a clear understanding of the project.

5.
Proposed Project Sponsor Readiness and Capacity

The application demonstrates that the local government is ready and able to begin the project within the TGM timetable and that there is local commitment and capability to manage the project considering the complexity of the project, the size of the jurisdiction, and performance on previous TGM projects. Where substantial coordination with other local, regional, and state planning efforts occurs (or will need to occur), all of the partners are ready and able to begin the project within the TGM timetable. 
Up to 5 points: Projects with a clear description of the jurisdiction’s capabilities and experience relative to the complexity of the proposed project will receive more points. Projects that lack a clear description of how the projects will be managed will receive fewer points. Projects that do not include a description of previous TGM projects (if any) and their performance will receive fewer points.

6.
Proposed Project is Innovative

The application demonstrates that the project will be innovative in its subject matter, approach, or expected outcomes. For example, the project will use health impact assessments or economic impact analysis as part of the evaluation of transportation alternatives.

Up to 10 points: By the nature of this criterion, most projects will not receive any points. Projects may receive some points for innovative project elements. Projects with innovative subject matter will receive more points.

TGM Staff Contacts

For general questions about the grant application process, contact Cindy Lesmeister at cindy.l.lesmeister@odot.state.or.us or 503.986.4349.

For specific advice on your project and assistance with filling out your grant application, contact our TGM planners, listed below.
ODOT Region 1
Lidwien Rahman

Portland

503.731.8229




lidwien.rahman@odot.state.or.us
ODOT Region 2
Naomi Zwerdling
Salem


503.986.2836



naomi.zwerdling@odot.state.or.us
ODOT Region 3
John McDonald
Roseburg

541.957.3688



john.mcdonald@odot.state.or.us
ODOT Region 4
Devin Hearing

Bend


541.388.6388




devin.hearing@odot.state.or.us
ODOT Region 5
Cheryl Jarvis-Smith

La Grande

541.963.1574




cheryl.jarvis-smith@odot.state.or.us
DLCD - Statewide
Bill Holmstrom

503.373.0050 extension 265



bill.holmstrom@state.or.us
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· http://egov.oregon.gov/ODOT/TD/TDATA/gis/docs/REGIONMAPS/RegionMap.pdf
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